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1. Audio Equipment 
Introduction 

The audio quality of a recording is determined by the quality of each 
component used, starting with the microphone and ending with the digital 
capture device. The equipment you need will depend on the format of your 
finished piece of media and your budget. These guidelines are intended to help 
you understand the differences and make the right decisions, but do not 
provide guidance on specific products. 

Microphones 
Microphones capture pressure waves in the air and translate them into an 
electrical signal. 

Dynamic mics are good general-purpose mics with few moving parts. They are 
sturdy and resistant to handling noise, so good for mobility. They are also 
suited to handling high volume levels, such as from instruments or amplifiers.  

Commonly used dynamic mics include: 

• Shure SM58 (from around £70) 
http://www.shure.co.uk/products/microphones/sm58 

• Sennheiser Evolution E 835 
 

Condenser mics have an internal amplifier to increase the audio signal strength. They tend to be more 
sensitive and responsive than dynamics, making them well-suited to capturing subtle nuances in voice. 
However, their sensitivity means they can't be hand-held and so require a sturdy stand. 

Two excellent condenser mics are available from Samson: 

• Go Mic - Portable USB Condenser Microphone (from around £30). 
http://www.samsontech.com/products/productpage.cfm?prodID=2010 

• C03U Studio condenser mic (from around £90) 
http://www.samsontech.com/products/productpage.cfm?prodID=1878 

Pickup patterns 
Omnidirectional mics pickup sound from all directions equally.  

Directional mics preferentially pickup sound from specific directions, rejecting sound from elsewhere.  

 Caroid: sensitive to front, less to sides, very little to rear. 

 Figure 8: sensitive to front and rear, but not sides. 

  

http://www.shure.co.uk/products/microphones/sm58
http://www.samsontech.com/products/productpage.cfm?prodID=2010
http://www.samsontech.com/products/productpage.cfm?prodID=1878
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Connectors 
These connect your microphone to your recording capture device. The higher quality the connection, the 
less noise is introduced through electrical interference. Unless absolutely necessary, avoid plugging a mic 
directly into a PC sound card as the connections are typically very low quality.  

XLR 
Used on professional microphones. Give best resistance to electrical 
interference. Plugs into a mixing desk. 

 

6.5mm (mono/stereo)  
Found on some professional microphones. Plug into range of capture 
devices, including computers via a 3.5mm adapter. 

 

3.5mm (mono/stereo) 
Plugs into most recording devices, including sound cards on most 
computers. 

 

USB 
Audio digitised within mic for transfer to computer. Allows high quality 
recording directly to a computer. 

 

 

Pop filter 
A pop is an audible 'pop' in your recording caused by overloading the diaphragm of the microphone 
(typically with the plosive consonants such as 'p' and 'b').  

You can prevent this with a pop filter (or 'popper-stopper'), which is a screen of acoustically transparent 
material positioned between your mouth and the microphone. This breaks up the bursts of air responsible 
for pops. You can buy them for around £10 (or even make them with a pair of tights and a coat hanger!). 

Mixer 
A mixing desk provides centralised control over multiple audio sources, combining them into a single 
master mix. Each source is plugged into a separate channel that can be controlled independently. The 
inputs are generally of very high quality (XLR connectors) that introduce very little noise during the 
amplification of the input signal. 

Mixers have multiple outputs, allowing you to connect headphones and monitoring speakers as well as 
the recording device. Modern desktop mixers also come with USB and/or FireWire outputs allowing direct 
connection to a computer. 

While a mixer may seem like overkill at first, they are invaluable when doing live recording, when you 
have more than one presenter and for the input quality.  
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Recording Device 
There is now a huge variety of equipment available for recording audio, from budget to professional 
quality. Detailed information on recording devices is available from: 

http://www.phon.ucl.ac.uk/resource/audio/recording.html 

  

http://www.phon.ucl.ac.uk/resource/audio/recording.html
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2. Mic technique 
Good microphone technique is about physical positioning, diction, speed, mouth form, presence, and 
more. An excellent resource on microphone use from JISC Digital Media is available at: 

http://www.jiscdigitalmedia.ac.uk/infokit/guide-to-microphones/  

Position the Microphone 
When recording speech, the microphone should be positioned directly in front of the speaker and as close 
as possible without causing distortion. In practise, a hands width generally gives a good level with a rich, 
warm tone.  Any closer risks overloading the diaphragm and 'popping' the plosive consonants ('p' and 'b') . 

You should also position the microphone slightly above you and off to one side by up to 45 degrees. This 
cuts down on mouth noises and helps reduce "pops."  

Consider standing up when you record - you may find it more natural. 

Be natural 
Talking into a microphone can feel a little strange at first, but the more you do it, the easier and more 
natural it becomes.  Try to think of your story as a conversation with a close friend, rather than a 
presentation to a large audience.  

Talking too quickly is a common mistake. Give yourself time to slow down and to try enough times to get 
the narration to where you want it. You may also find that you swallow small words (in, to and one-
syllable words), ignore commas, smack you lips, say 'um' and 'ah' more than you realised…  

Rehearse 
Even experienced storytellers rehearse their shows so that they get an idea of the structure and timings. 
You'll probably want to revise your original script after reading it aloud, changing the words and rhythm 
to be more like that which you actually spoke when you rehearsed. 

Listen to yourself 
This can be a painful exercise, but can dramatically improve your screencast (and any form of 
presentation). Don't be too surprised if your recorded voice sounds different – it does! The voice you hear 
when you speak passes through the bone and tissue of your head, making the sound deeper and richer. 
When played back, you hear only the sound transmitted through the air. 

  

http://www.jiscdigitalmedia.ac.uk/infokit/guide-to-microphones/guide-to-microphones-home
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3. Using Audacity 
You can download Audacity from: 

http://audacity.sourceforge.net/ 

This guide covers the most basic functions of Audacity. These and the more advanced features are 
covered in tutorials available from: 

http://wiki.audacityteam.org/wiki/Category:Tutorial 

Before Recording 

Setting Preferences 
From the Edit menu select Preferences 

On the Audio I/O set the recording device to your microphone. 

Set the Channels to 1 – mono for recording voice. 

On the Quality set the sample rate to 44,100 Hz.  

Leave the other settings at their default values and click OK.  

Setting Microphone Levels 

From the Monitor Toolbar click the arrow next to the microphone  to expand the menu. 

Select Monitor Input 

Begin speaking into the microphone. 

Using the microphone volume slider  set an appropriate level. 

Monitoring Microphone Levels 
The monitor toolbar will now provide live feedback as you record as shown below: 

 

 
The clipping Indicators will light up if your levels are too high (loud) and the signal is distorting. 

 

  

http://wiki.audacityteam.org/wiki/Category:Tutorial
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Toolbars 

 

Recording 

  To begin recording click Record.  

   If you want to pause while recording click Pause  

  When recording is complete click Stop  

Playback 

  To listen to your recording, click Play  

  To listen to part of your recording, choose the Selection Tool , highlight a section and click play.  

Zooming In/Out 

  Zoom In  

  Zoom Out 

  Zoom to Selection (zooms to show only selected audio) 

  Zoom to entire Project (zooms to show all audio) 

Cutting 

Choose the Selection Tool    

Click and Drag to select the audio you would like to delete. 

Press the Delete or Backspace key or select Edit > Delete. 

Saving 
While you are still working on your project you should save it as an Audacity project. This will allow you to 
continue editing your project at a later time. 

To save, go to the File menu and choose Save Project As. 

When you save an Audacity project you create both an Audacity file and a data folder. Both the file and 
the folder must be kept together in order for the project to open. 
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Exporting 
When you finish your recording, you should export it as an MP3 file for distribution online.  

Click File and choose Export as MP3 

Choose a destination and a name for your file. 

Click OK. 

Next, you’ll be prompted to include more information about your track (ID3 tags).   

Enter the recording information (optional). 

Click OK  
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4. Signal Processing 
Manipulating the audio level through techniques such as equalisation and compression can make your 
recording sound much more professional. However, over processing can have exactly the opposite effect, 
so it’s important to use it appropriately and in moderation. 

Equalisation (EQ) 
EQ is adjusting the tonal quality of audio by boosting or cutting at specific frequencies.  

Human hearing covers a range of 20Hz – 20 kHz, with speech lying in the midrange frequencies. 
Adjustments here can significantly improve audio quality. Changes outside this range can also impact on 
the overall sound as below.  

Below 60 Hz (extreme low bass). Contains little voice information and most multimedia 
speakers cannot reproduce this. It's good practice to roll off below 60Hz.  

60-250 Hz (low-end). Files with the right amount of low end sound warm. Too little sounds thin, 
too much sounds boomy.  

250 Hz-2 kHz (low-midrange). Too much sounds telephone-like. Cutting at 250-350 Hz can 
clarify speech.  

2 kHz-4 kHz (high-midrange). Most speech information lives here. Boosting around 3 kHz in 
speech makes it more intelligible.  

4 kHz-6 kHz (presence range). Boosting around 5 kHz can make voice seem closer.  

6 kHz-20 kHz (very high frequencies). Boosting adds "air" but can exaggerate sibilance.  

Worked EQ Example for Vocal Recording 
Most audio software will have built in set of EQ profiles that you can simply apply. However, you may 
wish to create your own profile that better reflects the type of audio you are editing. Too much EQ will 
give you an artificial, over-processed sound, so be subtle. 

1. Cut frequencies < 60Hz which contain little vocal information. 

2. Boost in midrange (2 - 4kHz) by 1.5db – 3db. 

3. Boost by 1.5db – 3db at 100Hz for a male voice; 200Hz for a female voice 

4. Boost all frequencies above 5kHz by 1.5db – 3db to add ‘sparkle’ 

Compression 
Reduces (compresses) the dynamic range of audio by reducing the level of sounds over a specified 
threshold. 

Good audio equipment has a large dynamic range, allowing you to capture and reproduce both very quiet 
and loud sounds. However, in situations where they are listening to your story in a noisy environment, on 
headphones for example, listeners may need to keep adjusting the playback volume.  

Compression evens out the overall level of your audio by turning down the loud sections, but not the 
quiet ones. This allows listeners to increase the level to hear the quiet sounds without the loud sounds 
becoming too loud.  
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Compression also improves the tone of most audio, boosting bottom end frequencies to make the sound 
fuller. This is one of the reasons that nearly all traditional audio broadcasts are compressed. 

Most compressors allow you to control threshold (level above which compression is applied), ratio (the 
amount of compression applied) and attack/release times (length of time that effect is applied for). 

Avoid compressing too heavily as audio with no dynamic range can be draining to listen to (AS 
EVERYTHING IS LOUD). 

Normalisation 
Audio normalization is the process of increasing (or decreasing) the volume of an audio signal. Typically 
normalization increases the peak amplitude to the maximum level possible without introducing 
distortion. This is useful where the recording level was low. 

Unlike compression, normalization applies the same amount of gain across the entire recording so that 
the relative dynamics are preserved. 

When normalising, be sure to leave headroom for any subsequent EQ by normalising to -3db (rather than 
to 0db). Alternatively, you can perform normalisation as the last step. 
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